BAB Il1
ANALISIS DAN DESAIN SISTEM

I11.1. Analisis Sistem yang Berjalan

Melihat kebutuhan akan informasi tentang Lokasi jasa pemasangan dan
penambalan ban tubeless merupakan hal yang penting bagi setiap masyarakat
yang ingin mengetahui lokasi jasa pemasangan dan penambalan ban tubeless
tersebut yang akan di promosikan. Namun kesulitan umum yang sering dialami
oleh mayarakat adalah tidak terdapat informasi yang cukup dan tidak mengetahui
alamat dan lokasi jasa pemasangan dan penambalan ban tubeless yang ada di Kota
Medan tersebut. Dalam aplikasi yang dibuat ini akan membantu masyarakat dalam
mendapatkan informasi lokasi jasa pemasangan dan penambalan ban tubeless
yang ingin diketahui. Menyajikan sebuah peta yang dapat berinteraksi dengan
penggunanya sehingga dapat memberikan informasi yang lebih akurat. Adapun
analisis sistem ini meliputi input, proses dan output yang dijabarkan sebagai
berikut :
I11.1.1. Formula Haversine

Haversine Formulla adalah persamaan yang digunakan dalam navigasi,
yang memberikan jarak lingkaran besar antara dua titik pada permukaan bola
(bumi) berdasarkan bujur dan lintang. Penggunaan rumus ini mengasumsikan
pengabaian efek ellipsoidal, cukup akurat untuk sebagian besar perhitungan, juga

pengabaian ketinggian bukit dan kedalaman lembah di permukaan bumi.
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Rumus Haversine:

2—-211
2

|
d =2+ sinl(‘\ll sin? ( 5 ) + cos(®1) cos(B2) 511128k

)

Ket: A =delta ini seperti konsantan dari variable
d = jarak
02 _ Jatitude awal

21 = |atitude akhir
A2 = longitude awal
A1 = longitude akhir

Rumus Haversine yang sudah di pecahkan dari rumus yang di atas :
a =sin*(A@/2) + cos @1 x cos @2 X sin*(AA/2)

¢ =2 x atan2( Va, V(1-a) ) = 2 x asin(Va)

d=Rxc

(Sumber : http://en.wikipedia.org/wiki/Haversine_formula)

Rute = [(3.57185,98.6896), (3.57158,98.68973), (3.57152,98.68976),
(3.57103,98.69001), ]

Perhitungan jarak koordinat (3.57185,98.6896) ke koordinat
(3.57158,98.68973):

Jarak ruas (3.57185, 98.6896) ke (3.57158, 98.68973):

A = radians(3.57158 - 3.57185)=-4.7123889803846E-6

A\ = radians(98.68973 - 98.6896)= 2.2689280275687E-6

a = power(sin(-4.7123889803846E-6 / 2);2) + cos(radians(3.57185)) *
cos(radians(3.57158)) * power(sin(2.2689280275687E-6 / 2);2)
a=6.8336661701991E-12

¢ =2 x asin(V6.8336661701991E-12) = 5.2282563709959E-6
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d =1609.34 x (6371 x 5.2282563709959E-6) = 1609.34 x 0.033309221339615 =
53.605862270695

Perhitungan jarak koordinat (3.57158,98.68973) ke koordinat
(3.57152,98.68976):

Jarak ruas (3.57158, 98.68973) ke (3.57152, 98.68976):

Ao = radians(3.57152 - 3.57158)=-1.0471975511957E-6

A) = radians(98.68976 - 98.68973)= 5.235987757645E-7

a = power(sin(-1.0471975511957E-6 / 2);2) + cos(radians(3.57158)) *
cos(radians(3.57152)) * power(sin(5.235987757645E-7 / 2);2)
a=3.4242862104399E-13

¢ =2 x asin(V3.4242862104399E-13) = 1.1703480184014E-6

d =1609.34 x (6371 x 1.1703480184014E-6) = 1609.34 x 0.0074562872252354
=11.99970128306

Perhitungan jarak koordinat (3.57152,98.68976) ke koordinat
(3.57103,98.69001):

Jarak ruas (3.57152, 98.68976) ke (3.57103, 98.69001):

A = radians(3.57103 - 3.57152)= -8.552113334774E-6

A\ = radians(98.69001 - 98.68976)= 4.3633231298826E-6

a = power(sin(-8.552113334774E-6 / 2);2) + cos(radians(3.57152)) *
cos(radians(3.57103)) * power(sin(4.3633231298826E-6 / 2);2)

a =2.3025840073486E-11

¢ =2 x asin(2.3025840073486E-11) = 9.5970495619565E-6
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d =1609.34 x (6371 x 9.5970495619565E-6) = 1609.34 x 0.061142802759225 =

98.399558192531

=53.605862270695 + 11.99970128306 + 98.399558192531 = 164.0051

Jadi, total Jarak Rute adalah 164.01 meter

111.1.2. Analisis Input

Analisis sistem input yang sedang berjalan pada sistem yang lama adalah
data ban tubeless dan data alamat jasa pemasangan dan penambalan ban tubeless
yang akan dipasarkan dalam bentuk brosur yang akan disebarkan kepada
masyarakat. Berikut adalah gambar jasa pemasangan dan penambalan ban

tubeless di salah satu cabang kota medan.

Selamat Datang
Website GIS

Lihat Peta

Judul Blog Judul Blog

Gambar I11.1. Iklan Jasa Pemasangan Dan Penambalan Ban Tubeless
111.1.3. Analisis Process

Proses yang terjadi pada sistem yang dijelaskan pada langkah-langkah:
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Sistem Informasi Geografis Jasa Pemasangan Dan
Penambalan Ban Tubeless Menggunakan Algoritma
Formula Haversine

Jasa Pemasangan Dan

Masyarakat
Penambalan 24
\\ MULAI )
h 4
Papan lklan / Brosur Papan Iklan / Brosur
Jasa Pemasangan = Pemasangan Dan
Dan Penambalan Penambalan
—__| B

Mengingat
Alamat

Mengunjungi [ Mengunjungi
Ban Tubeless Ban Tubeless

A 4

\/ SELESAI

Gambar I11.2. Flow Of Document

Phase

Penjelasan FOD :

1. Masyarakat mendapatkan informasi mengenai lokasi pemasangan dan
penambalan ban tubeless yang berada di kota Medan.

2. Kemudian Masyarakat mengingat atau mencatat alamat lokasi pemasangan
dan penambalan ban tubeless tersebut.

3. Setelah mendapatkan informasi Lokasi pemasangan dan penambalan ban
tubeless, Masyarakat melakukan pengunjungan ke lokasi pemasangan dan
penambalan ban tubeless yang mereka ketahui.

111.1.4. Analisis Output

Output yang dihasilkan dari sistem adalah informasi-informasi tempat

Lokasi yang ada di kota dan mengunjungi Lokasi pemasangan dan penambalan

ban tubeless yang di inginkan maka Masyarakat akan mendapatkan jasa pelayanan
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sesuai dengan kebutuhan Masyarakat yang diberikan oleh pihak Lokasi

pemasangan dan penambalan yang bersangkutan.

Tabel 111.1. Daftar Pemasangan Dan Penambalan Ban Tubeless

No

Nama Bengkel
Pemasangan Dan
Penambalan Ban

Tubeless

Alamat Lengkap Longitudinal Latitude

I11.2. Evaluasi Sistem yang Berjalan

Sistem yang sedang berjalan memiliki beberapa kelemahan yang

dijabarkan sebagai berikut:

1.

Tidak adanya sistem informasi geografis lokasi cabang pemasangan dan
penambalan ban tubeless khususnya di kota Medan sehingga konsumen
kesulitan menemukan Jasa.

Belum adanya sistem yang menentukan jarak terdekat antar jasa pemasangan
dan penambalan ban tubeless.

Penyebaran informasi mengenai pemasangan dan penambalan ban tubeless
tidak efisien dan efektif dikarenakan penyebaran informasi hanya di dapatkan

melalui berita iklan.
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111.3. Desain Sistem

Berdasarkan hasil analisa sistem pada penelitian ini dibagi menjadi dua
desain, yaitu desain sistem secara global untuk penggambaran model sistem
secara garis besar dan desain sistem secara detail.
111.3.1. Desain Sistem Secara Global

Desain sistem secara global menggunakan bahasa pemodelan UML yang
terdiri dari Usecase Diagram, Class Diagram, Activity Diagram dan Sequence
Diagram.
111.3.1.1. Usecase Diagram

Secara garis besar, bisnis proses sistem yang akan dirancang digambarkan

dengan usecase diagram yang terdapat pada Gambar 111.3 :

Sistem Informasi Geografis Jasa Pemasangan Dan Penambalan Ban
Tubeless Menggunakan Algoritma Formula Haversine

L Data Konten S

<include> -

<extends>
Data Bengkel gextends>»— Upload Gambar

<extends>

Upload

anclude> Thumbnail

<include>

Peta Jasa

User

Administrator

Daftar Bengkel

Gambar 111.3. Use Case Diagram Sistem Informasi Geografis

111.3.1.2. Activity Diagram

Bisnis proses yang telah digambarkan pada use case diagram di atas

dijabarkan dengan activity diagram :
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1. Activity Diagram Melihat Peta

Aktivitas melihat peta diterangkan dalam langkah-langkah state, dimulai dari
kegiatan melihat panel peta kemudian mencari Artikel Lokasi Pemasangan dan
Penambalan ban tubeless, selanjutnya menekan tombol atau link yang ada pada
peta dan yang terakhir melihat informasi yang di sajikan dalam peta yang

ditunjukkan pada gambar 111.4:

®
Y

Halaman Utama
Click Peta Jasa Pemasangan
Dan Penambalan

< Click Salah Satu marka jasa >
Pemasangan Dan Penambalan

< Melihat Informasi Lokasi jasa >

®

Gambar 111.4. Activity Diagram Melihat Peta

2. Activity Diagram Login Administrator Website

Aktvitas proses login admin diterangkan dalam langkah-langkah state,
dimulai dari memasukkan username, memasukkan password, jika profil valid
maka sistem akan mengaktifkan menu administrator, sedangkan jika tidak valid,

maka tampilkan pesan kesalahan yang ditunjukkan pada gambar I11.5:
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®

[ Memasukkan Username

L

[ Memasukkan Password j

i Valid invalid i

[Aktifkan Menu Administrator] [ Menampilkan Pesan Error ]

0

Gambar I11.5. Activity Diagram Login Admin

3. Activity Diagram Mengolah Data Lokasi Pemasangan dan Penambalan ban
tubeless
Aktivitas proses mengolah data Lokasi Pemasangan dan Penambalan ban
tubeless diterangkan dalam langkah-langkah state yang ditunjukkan pada gambar

11.6:

<Memi|ih aksi pada form data Bengkel
pemasangan dan Penambalan

Pencarlan Tambah Edm Hapus

< Memilih Pencarian >< Mengisi Data >< Memilih Data > < Memilih Data >

<Menget|k Kata Kunu> < Menylmpan Data > < Mengubah Data > < Konflrma5|
Penghapusan

< Menekan Enter > <Menzl:;np:§mbol> < Menyimpan Data > < Menghapus Data Ya

Tidak

"
O

Gambar 111.6. Activity Diagram Mengolah Data Lokasi
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4. Activity Diagram Mengolah Data Buku Tamu
Aktvitas proses mengolah data Buku Tamu diterangkan dalam langkah-
langkah state yang ditunjukkan pada gambar 111.7:

¢

C Memilih aksi pada form Buku Tamu X

Tambah Hapus

C Mengisi Data ) ( Memilih Data )
J, " f>|/ _ Tidak
C Menyimpan Data ) onfirmasi
Penghapusan va

CMenekan Tombol) C Menghapus Data \L

Kirim

@)
(@

Gambar I11.7. Activity Diagram Mengolah Data Buku Tamu
5. Activity Diagram Mengolah Data Blog
Aktvitas proses mengolah data Blog diterangkan dalam langkah-langkah state

yang ditunjukkan pada gambar 111.8:

?

C Memilih aksi pada form Blog }

T

Pencarian Tambah Edit H

apus
C Memilih Pencarian ) C Mengisi Data ) C Memilih Data ) C Memilih Data )

1 1 1 1 Tidak

Mengetik Kata Kunci Menyimpan Data Mengubah Data Konfirmasi
Penghapusan

C Menekan Enter ) CMenZl;;np:zmboID CMenyimpan Data) C Menghapus Data ) Ya

O

Gambar 111.8 Activity Diagram Mengolah Data Blog
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6. Activity Diagram Mengolah Upload Gambar
Aktvitas proses mengolah data upload gambar diterangkan dalam langkah-
langkah state yang ditunjukkan pada gambar 111.9:

¢

G\/Iemilih aksi pada form upload gamban,

———

Upload Download Hapus

Chose File > C Memilih data > C Memilih Data >
K f Tidak
Memilih gambar > onfirmasi
Penghapusan
Ya
CMenekan Tombol> Menekan Tombol C Menehaous Data
upload download ghap )(—

&

Gambar 111.9. Activity Diagram Mengolah Data Upload Gambar

7. Activity Diagram Mengolah Upload Thumbnail

Aktvitas proses mengolah data upload thumbnail diterangkan dalam langkah-

langkah state yang ditunjukkan pada gambar 111.10:

C

thumbnail

Memilih aksi pada form upload \/

—

Upload

Download

Hapus

Chose File > C Memilih data > C Memilih Data
K f Tidak
Memilih thumbnall> onfirmasi
Penghapusan
Ya
CMenekan Tombol> Menekan Tombol C Menehaous Data
upload download ghap )(—

Gambar 111.10. Activity Diagram Mengolah Data Upload Thumbnail

&
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Rancangan kelas-kelas yang akan digunakan pada sistem yang akan dirancang

dapat dilihat pada gambar 111.11 :

4 Bengkel h : jalan )
) - Kode_Tempat - Kode_Jalan - Kode_Tempat
i - Nama_Bengkel - Nama_Jalan - jarak_mil
- hame - Alamat - Tipe_Jalan - jarak_KM
~type - Gambar -Lon - waktu_tempuh
- Slze - & (- Lat
- content
\ / - Lat
sing using |
j—i T
4 Connection h
using > < 4 konten N
e ) ConnectionManager()
( komentar >, - Kode_Konten
4 - Tanggal

- Kode_Komentar usingusing - Terbit
-Nama using - Judul
- Email - Isi
- Tanggal - Thumbnail
- Pesan T — .

a thumbnail h usind/ user w

-id

_ Iname -1d_User

~type - Username

: - Password

- size [,

- content

N~

Gambar I11.11. Class Diagram Sistem Informasi GIS

111.3.1.4. Sequence Diagram

Rangkaian kegiatan pada setiap terjadi event sistem digambarkan pada
sequence diagram berikut:
1. Sequence Diagram pada Form Peta

Serangkaian kegiatan saat terjadi event pada form peta dapat dilihat pada

gambar I11.12 :



40

r FO FO

User Main form Form Peta

Tampilkan |
Menu ()

click form Peta () _

database ()

I
I
I
I
I
I
| Koneksi
o
I
I I

Gambar 111.12. Sequence Diagram Form Peta
2. Sequence Diagram pada Form Login
Serangkaian kegiatan saat terjadi event pada form login dapat dilihat pada
gambar 111.13 :

: KO O O O

Administ.rator Main form Form Login Proses Login Halaman
Website Administrator

Tampilkan Fom ()
Ij:lMenu ()

| Validasi nama

|

I

|

|

I

|

click form login dan password () |
D D |:| I
|

I

|

|

I

|

|
| -
|
l Invalid ()
Login sukses ()
|
|
I
|

|
Gambar 111.13. Sequence Diagram Form Login
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3. Sequence Diagram pada Form Data Pemasangan Dan Penambalan Ban
Tubeless
Serangkaian kegiatan saat terjadi event pada form Pemasangan Dan
Penambalan Ban tubeless dapat dilihat pada gambar 111.14 :

? KO KO O O

Administrator Main form Form Data Bengkel Proses Bengkel
Website
M \

D \
Tampilkan Fom () ‘
\
\
Menu () ‘
click form ‘
Bengkel () D
|
Koneksi
database ()

update data ()

Koneksi
database ()

Close form () ‘
Update
| data Bengkel
«———————— E

\ \

\ \

\ \ \
] \ \ \

Gambar 111.14. Sequence Diagram Form Bengkel Ban Tubeless

4. Sequence Diagram pada Form Data Konten
Serangkaian kegiatan saat terjadi event pada form data konten dapat dilihat

pada gambar 111.15 :
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I FO FO O O

Administrator
Website

Tampilkan Fom ()
Menu ()

click form
Blog ()

Main form Form Blog Proses Konten

-

update data ()

\

\

\

\

[
Koneksi
database ()

delete data ()
Koneksi
database ()
Close form () | |
Update

‘ konten

|
| e
|

]

\ \
Gambar 111.15. Sequence Diagram Form Data Konten

5. Sequence Diagram pada Form Data Buku Tamu
Serangkaian kegiatan saat terjadi event pada form buku tamu dapat dilihat

pada gambar 111.16 :

r FO O O O

Administrator Main form  Form Data Buku Tamu Proses Buku tamu
Website

Tampilkan Fom ()
E——

D \
\

\
(oo
Menu () [

[

‘ click form

\
\
\
\
\
\
Buku Tamu () D
)

update data (
Koneksi
database ()
| deletedata() _|
Koneksi
database ()
Update
ku tamu

)

Close form ()

]

\
\
| \
i \ \ \
Gambar 111.16. Sequence Diagram Form Buku Tamu
6. Sequence Diagram pada Form Upload Gambar
Serangkaian kegiatan saat terjadi event pada form upload gambar dapat dilihat

pada gambar 111.17 :
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I O FO O O

Administrator Main form Form Upload Gambar Proses gambar
Website

\ \ ‘
Tampilkan Fom () D |
|
|
|
|

[m Menu ()

click form
Upload Gambar
upload data ()

I

|

I

I

|

I

I

Koneksi ‘
database () |
owniond data \
I

I

I

I

I

|

|

I

elete data ()
Koneksi

database ()
Close form () | | Update

F—D data gambar

\ \ . ________

] \ \ |

Gambar 111.17. Sequence Diagram Form Upload Gambar

[

I

| | download data ( |

| Koneksi
database ()

! T

| di

\

|

7. Sequence Diagram pada Form Upload Thumbnail
Serangkaian kegiatan saat terjadi event pada form upload thumbnail dapat

dilihat pada gambar 111.18 :

r O O O O

Administrator Main form  Form Upload Thumbnail Proses thumbnail
Website

\ \ !
Tampilkan Fom () D
—— |

\ \
\ \
\ \
Menu () | |
\
;|
j Koneksi

\

\

\

\

click form | ‘
pload Thumbnail |
\

\

database () [

”””” \

\

\

\

\

\

\

\

\

upload data (

delete data ()
Koneksi
database ()

Close form () | | Update
D‘ﬁ data thumbnail
\ \
i | | D ‘
Gambar 111.18. Sequence Diagram Form Upload Thumbnail

\

\

‘ ‘ download data ( ‘

| Koneksi

| database ()
\

\

\

111.3.2. Desain Sistem Secara Detail
Tahap perancangan berikutnya yaitu desain sistem secara detail yang meliputi

desain output sistem, desain input sistem, dan desain database.
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111.3.2.1. Desain Output

Berikut ini adalah rancangan tampilan desain peta yang akan dihasilkan oleh
sistem:
1. Rancangan Form Peta

Form peta berfungsi untuk menampilkan lokasi — lokasi Pemasangan dan
Penambalan ban tubeless yang disajikan dalam bentuk peta, rancangan dapat

dilihat pada gambar berikut :

Peta Sistem Informasi Geografis Lokasi Penambalan Ban Tubeless

Peta

Nama Bengkel VH H Cari Data

Gambar 111.19. Desain Tampilan Peta

2. Rancangan Form Daftar Pemasangan dan Penambalan ban tubeless
Form daftar Dealer berfungsi untuk menampilkan informasi — informasi
Pemasangan dan Penambalan ban tubeless yang disajikan dalam bentuk tabel,

rancangan dapat dilihat pada gambar berikut :
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Gambar

Judul Blog

Gambar

Judul Blog

Gambar

Judul Blog

Gambar

Judul Blog

111.3.2.2. Desain Input

Gambar 111.20. Desain Tampilan Daftar

Berikut ini adalah rancangan atau desain input sebagai antarmuka pengguna:

1. Desain Form Login

Desain form login dapat dilihat pada gambar 111.21 :

Selamat Datang
Website GIS

XXXX

Lihat Peta

Gambar

‘Login Admin

User Name ‘

Password ‘

Gambar I11.21. Desain Form Login



2. Desain Form Data Lokasi Pemasangan Dan Penanbalan Ban Tubeless
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Desain form Data Lokasi Pemasangan dan Penambalan ban tubeless dapat

dilihat pada gambar 111.22 :

‘Form Pengisian Lokasi Bengkel

Nama Bengkel

Alamat

Keterangan

\
Gambar Bengkel

Koordinat

Tambah

Reset

Peta

‘ Nama Bengkel H

‘ ‘ Cari Data ‘

3. Desain Form Data Konten

Desain form Data Konten dapat dilihat pada gambar 111.23 :

Gambar 111.22. Desain Form Lokasi Bengkel

‘Pengolahan Blog Website

Judul

Diterbitkan

Tambah

Reset

‘ Judul H

‘ ‘ Cari Data ‘

Gambar 111.23 Desain Form Data Konten
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Desain Form Data Pangkalan Buku Tamu

Desain form Data Pangkalan Buku Tamu dapat dilihat pada gambar 111.24 :

Selamat Datang
Website GIS

XXXXXXXXKRXXHXXKXXHRXXKXXKXXKXXKXXKXXKXXX
XXXXXXXXXKXKXXKKXHKXHKKXKKXKKXKKXKXXKXXX
XXXXXXKXKRXXKKXKKXKKXKKXKKXHKKXKKXKKXKKXX Gambar
XXXXXXXXKRXXHXXHXXHXXHXXKXKHKXXKXXKXKKXKX
XXXXXXXXHRXXHEXXHXXHRXXHXXKXXKRXXKXXKXXKXXX
XXXXXXXXXKXXKXKKXHKXHKKXKEKXKKXKKXKXXKKXX
XXXXXXKXXKKXKKXKKXKKXKKXKKXKKXKKXKKXKKXX
XXXXXXX

Lihat Peta

Yetti

Waktu

Test

Hapus

5.

Gambar 111.24. Desain Form Buku Tamu
Desain Form Data Upload Gambar

Desain form Data upload gambar dapat dilihat pada gambar 111.25 :

Selamat Datang
Website GIS

PO 0000000000000 00.0.0.0.0.0.00.00000.0009.0.000004
OO OOO 000000 0000000000000 000 0000.00.00.0.0.04
XXXXXXXHKXXXHXKXIXIXKXXIXXKXIXXKXKIXXKXXXXXKXXK Gambar
XXXXXXXXKXRXRXRXXXXXKXKXKXXXXKKKXXXXXXXXXXXXX
PO OO0 00,0000 0000.0.00.0.0.0.0.0.0.00.000.0.0.00.00,.0.0.04
XXXXXXXXXXRXXXXXXXKXXKXXXXXKKXRXXXXXKXXKXXXXX
OO OO00000.00 00 00000.00.0.0.0.0.00.0000.0.00.0.0,.0.0.04
XXXXXXX

Lihat Peta

‘Pilih Lokasi Gambar

[[Pili File] Tidak ada file yang dipilih || Upload |

‘Daftar Gambar Untuk Sisifo pemasangan ‘

Gambar 111.25. Desain Form Data Upload Gambar
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6. Desain Form Data Upload Thumbnail

Desain form Data upload thumbnail dapat dilihat pada gambar 111.26 :

Selamat Datang
Website GIS

PO OOOO00000. 00000000 000000.0.00.0000.0.00.0.0.04
PO O0000.0.0.0.0.00.000000.0.0.0.0.000.00.00900.0.0.0.0.04
XXXXHXXXKHXXXKHXXXIXHXKXIEXHXXXIXHXHXIXEXXXXXKXXXXXK Gambar
PO 000000000000 00 000.0.0.0.0.00.000.00000.00.00.04
XXXXXXXXXKKKKRXRXXXXKX XXX XKKKKXRXXXXX XXX
P 0.0,0.0.0.0,0.0.0,0,0.0.0.0.0.0.0.0.0.0,0.0,0.0,.0.0,0.0,0.0.00.00.0.0.0.4
XXXXXXXXXKXKKRXRXXXXXKX KKK XXKXKXXXXXX XXX
XXXXXXX

Lihat Peta

‘Pilih Lokasi Gambar ‘

[[Pilih File] Tidak ada file yang dipilih || Upload |

‘Daftar Gambar Untuk Blog ‘

Gambar 111.26. Desain Form Data Upload Thumbnail

111.3.2.3. Desain Basis Data

Desain basis data terdiri dari tahap merancang kamus data, melakukan
normalisasi tabel, merancang struktur tabel, dan membangun Entity Relationship
Diagram (ERD).
111.3.2.3.1. Kamus Data

Kamus data merupakan sebuah daftar yang terorganisasi dari elemen data
yang berhubungan dengan sistem, dengan definisi yang tepat dan teliti sehingga
pemakai dan analis sistem akan memiliki pemahaman yang umum mengenai
input, output, dan komponen penyimpan. Kamus data penyimpanan sistem yang
akan dirancang dapat dilihat sebagai berikut :

1. Gambar = @Id + Name + Type + Size + Content.
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2. Bengkel = @Kode_Tempat + Nama_Bengkel + Alamat + Gambar +
Lon + Lat + Keterangan.

3. Jalan = @Kode_Jalan + Nama_Jalan + Tipe_Jalan + Lon + Lat.

4. Jarak = @Kode Tempat + Jarak Mil + Jarak Km +

Waktu_Tempuh.

5. Komentar @Kode_Komentar + Nama + Email + Tanggal + Pesan.

6. Konten = @Kode_Konten + Tanggal + Terbit + Judul + Isi +
Thumbnail.

7. Thumbnail = @]Id + Name + Type + Size + Content.

8. User = @Ild_User + Username + Password + Nama.

111.3.2.3.2. Desain Tabel
Setelah melakukan tahap normalisasi, maka tahap selanjutnya yang dikerjakan
yaitu merancang struktur tabel pada basis data sistem yang akan dibuat, berikut ini

merupakan rancangan struktur tabel tersebut:

1. Struktur Tabel Bengkel

Tabel Dbengkel digunakan untuk menyimpan data Kode Tempat,
Nama_Bengkel, Alamat, Gambar, Lon, Lat, Keterangan, selengkapnya mengenai

struktur tabel ini dapat dilihat pada tabel I11.5 di bawah ini:

Tabel 111.2. Rancangan Tabel Bengkel

Nama Database tubeless_gis
Nama Tabel bengkel

No Nama Field Tipe Data Boleh Kosong Kunci
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1. Kode_Tempat int(5) Tidak Primary Key
2. Nama_Bengkel varchar(25) Tidak -
3. Alamat Text Tidak -
4. Gambar int(11) Tidak Foreign Key
5. Lon double Tidak -
6. Lat double Tidak -
7.  Keterangan text Tidak -

2. Struktur Tabel Gambar

Tabel gambar digunakan untuk menyimpan data Id, name, type, size, content,

selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel I111.6 di bawah

ini:
Tabel 111.3. Rancangan Tabel Gambar
Nama Database tubeless_gis
Nama Tabel gambar
No Nama Field Tipe Data Boleh Kosong Kunci
1. Id int(11) Tidak Primary Key
2. name Teks Tidak -
3. type varchar(30) Tidak -
4. size Int(11) Tidak -

5. content longblob Tidak -



3. Struktur Tabel Jalan

o1

Tabel jalan digunakan untuk menyimpan data Kode Jalan, Nama_Jalan,

Tipe_Jalan, Lon, Lat, selengkapnya mengenai struktur tabel ini dapat dilihat pada

tabel 111.7 di bawah ini:

Tabel 111.4. Rancangan Tabel Jalan

Nama Database tubeless_gis
Nama Tabel Jalan
No Nama Field Tipe Data Boleh Kosong
1. Kode_Jalan int(5) Tidak
2. Nama_Jalan varchar(30) Tidak
3. Tipe_Jalan varchar(10) Tidak
4. Lon double Tidak
5. Lat double Tidak

4. Struktur Tabel Jarak

Kunci

Primary Key

Tabel jarak digunakan untuk menyimpan data Kode Tempat, Jarak Mil,

Jarak_Km, Waktu Tempuh, selengkapnya mengenai struktur tabel ini dapat

dilihat pada tabel 111.8 di bawah ini:

Tabel 111.5. Rancangan Tabel Jarak

Nama Database tubeless_gis
Nama Tabel jarak
No Nama Field Tipe Data

1. Kode Tempat int(5)

Boleh Kosong Kunci



2. Jarak_Mil double
3. Jarak_Km double
4.  Waktu_Tempuh double

5. Struktur Tabel Komentar

Tidak

Tidak

Tidak
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Tabel komentar digunakan untuk menyimpan data Kode Komentar, Nama,

Email, Tanggal, Pesan, selengkapnya mengenai struktur tabel ini dapat dilihat

pada tabel 111.9 di bawah ini:

Tabel 111.6. Rancangan Tabel Komentar

Nama Database tubeless_gis
Nama Tabel komentar
No Nama Field Tipe Data
1. Kode_Komentar int(5)
2. Nama varchar(25)
3. Email varchar(25)
4. Tanggal Datetime
5. Pesan Text

6. Struktur Tabel Konten

Boleh Kosong

Tidak

Tidak

Tidak

Tidak

Tidak

Kunci

Primary Key

Tabel konten digunakan untuk menyimpan data Kode_ Konten, Tanggal,

Terbit, Judul, Isi, Thumbnail, selengkapnya mengenai struktur tabel ini dapat

dilihat pada tabel 111.10 di bawah ini:
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Tabel 111.7. Rancangan Tabel Konten

Nama Database tubeless_gis
Nama Tabel konten
No Nama Field Tipe Data Boleh Kosong Kunci
1. Kode_Konten int(11) Tidak Primary Key
2. Tanggal timestamp Tidak -
3. Terbit varchar(6) Tidak -
4. Judul text Tidak -
5 Isi text Tidak -
6. Thumbnail int(11) Tidak Foreign Key

7. Struktur Tabel Thumbnail

Tabel thumbnail digunakan untuk menyimpan data Id, name, type, size,

content, selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel 111.11 di

bawah ini:
Tabel 111.8. Rancangan Tabel Thumbnail
Nama Database tubeless_gis
Nama Tabel Thumbnail
No Nama Field Tipe Data Boleh Kosong Kunci
1. Id int(11) Tidak Primary Key

2.  hame text Tidak -
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3. type varchar(30) Tidak -
4. size int(11) Tidak -
5.  content longblob Tidak -

8. Struktur Tabel User

Tabel user digunakan untuk menyimpan data Id_User, Username, Password,

Nama, selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel 111.12 di

bawah ini:
Tabel 111.9. Rancangan Tabel User
Nama Database tubeless_gis
Nama Tabel user
No Nama Field Tipe Data Boleh Kosong Kunci
1. Id_User int(11) Tidak Primary Key
2. Username varchar(12) Tidak Unique
3.  Password varchar(12) Tidak -
4. Nama varchar(25) Tidak -

111.3.2.3.3. ERD (Entity Relationship Diagram)
Tahap selanjutnya pada penelitian ini yaitu merancang ERD untuk
mengetahui hubungan antar tabel yang telah didesain sebelumnya, ERD tersebut

dapat dilihat pada gambar 111.27 :



Mengolah Data

M

Kode_Tempat

Gambar

bengkel

1

Kode_Jalan

Nama_Jalan
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Kode_Konten

Tanggal

Tipe_lalan Konten

1

Kode_Komentar

Komentar

Tanggal

Thumbnail

Gambar 111.27. Diagram ERD

Thumbnail



